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Abstract

R is a language and environment for statistical computing and graphics, which provides a wide
variety of statistical tools (modeling, statistical testing, time series analysis, classification problems,
machine learning, ...), together with amazing graphical techniques and the great advantage that
it is highly extensible. Nowadays, there is no doubt that it is the software par excellence in
statistical courses for any level, for theoretical and applied subjects alike. Besides, it has become
an almost essential tool for every research work that involves any kind of analysis or data
visualization. Furthermore, it is one of the most employed programming languages for general
purposes. The goal of this work is helping to share ideas and resources to improve teaching
and/or research using the statistical software R. We will cover its benefits, show how to get started
and where to locate specific resources, and will make interesting recommendations for using R,
according to our experience. For the classroom we will develop a curricular and assessment
infrastructure to support both dissemination and evaluation, while for research we will offer a
broader approach to quantitative studies that provides an excellent support for work in science
and technology.
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1. Introduction

There is wide evidence of the necessity of statistical knowledge in the field of actual sciences.
For this reason, Statistics occupies a permanent place in the curricula degrees of a very diverse
nature, either with the purpose of allowing us to analyze the data form research or with the aim of
enable us to understand the data from published researches. A key topic in any science is how to
make calculations, because it is essential to use adequate tools. Especially for teaching, there is
some controversy about making hand calculations versus using appropriate software. According
to our experience as teachers and researchers, making simple hand computations with a small
dataset can be useful for truly understanding how the method works, but some examples should
be enough. However, employing adequate software is mandatory for developing applied and
practical skills about statistical methods, and it allows us to start asking and answering really
interesting questions. In fact, until a statistical technique is not assimilated in a popular software,
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it is rarely employed, regardless of its importance or advantages. For these reasons, in the last
decades, many families of statistical packages have been developed (as Matlab, Minitab, PSPP, R,
SAS/STAT, SPSS, Stata, Statgraphics, Statistica, SLSTAT), which arises the question of deciding
which one to employ. The purpose of this work is not to make a comparative analysis between
them, but to show the R framework, with recommendations about how to use it. Our extensive
experience has driven us to choose it, because it has shown to be of great utility, both for teaching
and research, and it has many advantages that we will describe below.

R was created in 1992, but announced to the public in 1993. In 1995, Martin Mächler, of the
Federal Institute of Technology in Zurich persuades Ross and Robert to use the GNU license to
make R free software, and it becomes part of the project from 1997. However, until February
29, 2000, the software was not considered complete and stable enough to release version 1.0. R
[1] is a GNU project, similar in appearance to the S language but the underlying implementation
and semantics are derived from Scheme [2], developed at Bell Laboratories, available as free
software under the terms of the Free Software Foundations’s GNU General Public License in
source code form. It compiles and runs on a wide variety of UNIX platforms and similar systems
as FreeBSD or Linux, Windows and MacOS or even in platforms as improbable as a PlayStation.

The growth in the number of R users in recent years indicates that researchers around the
world are either using R or will use it at some point. Despite of its initial design, focused on a
very precise objective (data analysis), it appears within the top ranks of programming languages
for general purposes. For example, it appeared in 13th position in TIOBE Index for May 2023;
7th position in Popularity of Programming Language, 8th position in IEE Top Programming
Languages 2022 or 12th in RedMonk.

There are several advantages of using R for statistical computing, apart from its open and
free source. The benefits of R for an introductory student and instructors are many and varied.
R is a high-level programming language and environment for statistical computing and graphics
which allows users to perform a wide array of sophisticated operations with only a few, and
often intuitive, lines of code, especially suitable for the classroom. Even for students and users
with little programming background, R can be easy and intuitive to learn. In addition, statistical
modelling and analysis can be performed by executing instructions that use pre-programmed
functions, which make more accessible for an applied researcher to use rather than coding its
own functions. R has a rich variety of user-contributed packages, including many teaching-
related packages, for generating advanced and customizable graphs (R Graph Gallery [3]), ...
and an excellent built-in help system and various online help pages including mailing list and
boards.

Many statisticians and data scientists use R with the command line. Rather than pointing
and clicking in a graphical environment, they write code statements to ask R to do something.
This has the advantage of providing a record of what was done, which is increasingly required as
part of a publication submission, and allows for peer review of the work undertaken. However,
the command line can be quite daunting to a beginner of R. Fortunately, there are many different
graphical user interfaces (GUI), many of which offer Integrates Development Environment (IDE)
facilities, that help to flatten the learning curve.

2. Brief introduction to R

After R is downloaded and installed, we simply need to find and launch it from our Applications
folder. As R is a command line driven program, the users enter commands at the prompt (>),
which are executed one at a time (Figure 1). R works with objects, which store data, and
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commands that can operate on them. A single number or string of text is the simplest object,
which is simply a vector of length one, because there is no distinct object type for a scalar.

Values are assigned to name variables with an arrow (<- or ->) or an equal sign (=). R makes
calculations using arithmetic operators, comparisons and logical operations.

Figure 1: R used interactively from terminal.

The workspace is our current Rworking place and it includes the user-defined objects (vectors,
matrices, data frames, list and functions). When we finish an R session, we can save an image of
the current workspace that is automatically reloaded the next time R is started.

2.1. Entering or reading data

We can either type the data manually or read it from a file, which is fairly simple, because it
offers options to import many file types, from CSVs to databases with commands as read.table,
scan, data or attach, depending on our situation.

R allows the following data structures:

• The basic structure in R is the vector with all elements of the same type (numeric, character
or logical). Most arithmetic operations are vectorized, i.e. the operations are applied
element-wise. When one operand is shorter than the other, the first one is recycled, i.e. the
values from the shortest one are reused in order to have the same length as the largest, and
a warning is printed.

• Matrices are two dimensional vectors created with the matrix function.

• Data frames are the most flexible data structure used to store datasets in spreadsheet-like
tables. Usually, the observations are the rows and the variables are the columns.



• Lists are very powerful data structures, consisting of ordered sets of elements, that can
arbitrary store different types of R objects.

A distinctive feature of R is that some functions can make data structures to be coerced
(i.e. internally converted) from one type to another automatically when needed, or the user can
employ specific functions for it (like as.vector, as.matrix...).

2.2. Loops and conditionals

R allows the implementation of control-flow constructs. The most commons are:
for(var in seq) expression

while(condition) expression

if(condition) expression

if(condition) cons.expression else alt.expression

They function in much the same way as control statements in any Algol-like language.
The ifelse function presents an advantage over the standard if statement, because it combines

element-wise operations (vectorized) and filtering with a condition that is evaluated, which
involves greater efficiency. An example of use can be seen in the Figure 2. We can appreciate
the great reduction in computation times.

Figure 2: The codes compares the simulation of a sequence of 108 values from a Laplace distribution with parameters
0 and 1, by combining for and if and by using ifelse, by means of calculating the computation times for both
procedures.

2.3. Geting help

There is a comprehensive built-in help system which can be used with any of the following
command:

2.4. Programing

R is an interpreted language (like Java or Python), and not a compiled language (like Fortran,
Pascal, C, C++). Commands typed on the keyboard are executed directly without the need to
build an executable file, making easy to analyze complex data. It supports procedural programming
with functions and, for some functions, object-oriented programming with generic functions.



Table 1: Help and documentation.

help.start() general help html based

help(nombre function) description of the function, possible arguments
?nombre function and values used as default, references, and usage examples

??string show all the topics matching “string”

apropos("nombre") list all functions containing string “nombre”

example(nombre function) show some examples of how the function can be used

Due to its S heritage, R uses its syntax to represent data and code and has stronger object-oriented
programming features than most statistical computing language. Advanced users can write C,
C++. Java, Python or NET code to manipulate R objects directly.

2.4.1. R-functions
Almost everything in R is done through functions. A function is a set of statements to perform

a specific task. R has a large number of built-in functions, addressing a wide variety of problems,
which can be directly called. Most of them are coded in R, although to increase efficiency, there
are functions coded in low level languages like C or Fortran.

The user can easily create their own functions. It may accept arguments or parameters (one,
several or an indefinite number) and it can return one or more values (or not). The basic syntax
is as follows:

function name <- function (arg1, arg2, ...) { function body }

The parts of a function are:

• Function name, which is stored in R.

• Optional arguments, which can have default values, are placeholders. When a function is
called, it passes a value to the argument without almost default values.

• Function body contains a collection of declarations that define what the function does.

• Return value is the last evaluated expression.

Functions are first-class objects and can be manipulated in the same way as data objects, making
it easy to do metaprogramming that allows multiple dispatch. Function arguments are passed by
values and are only evaluated when used, not when the function is called. A generic function
can act differently depending on the classes of the arguments passed to it, because it passes the
specific method implementation for that particular class.

Note that by using built-in functions, the only thing you need to worry about is how to
effectively communicate the correct input arguments and manage the return values.
¿How to obtain the code of a function?

Another advantage to point out, is the fact that we can access the code of the R functions,
because it allows us to learn through its reading and reuse them to adapt to new needs or
situations. The easiest way to do it is typing the name of the function without parenthesis.
For example, in Figure 3, we can see the code of function sd without the comments, which were



suppressed to save memory. If we want to access the original source code, we can download it
directly from the Comprehensive R Archive Network (CRAN). CRAN is a network of ftp and
web servers around the world that store identical, up-to-date, versions of code and documentation
for R. 1

Sometimes, the function calls a partially hidden one, in a namespace. For example, it happens
for the mean function, as we can see in Figure 3. UseMethod() hides the code, but it lets us know
whether it is a generic S3 function that calls a specific method, appropriate for the class of the
object. We can ask for it typing methods() and access it through getAnywhere function.

2.5. Contributed Packages
Packages are collections of R functions, data, and compiled code in a well-defined format. R

comes with a standard set of packages but it is highly extensible through the use of packages for
specific functions and applications.

Currently, the CRAN packages repository features near 20000 available packages [4], and
we can obtain the names of all them with rownames(available.packages()). They can be
easily installed typing:
> install.packages(‘‘package name’’)

and pressing Enter to proceded with the installation form a mirror. To start using some installed
package, we will need to load
> library(package name)

We can write our own packages and contribute to CRAN.
All the packages are tested regularly on machines running Debian GNU/Linux, Fedora,

macOS (formerly OS X) and Windows.
CRAN Task Views aim to provide some guidance about which packages are relevant for tasks

related to certain topics. Currently, there are 42 views available, (Table 2) which can be installed
automatically, with the function install.views from package ctv
> install.packages(‘‘ctv’’) # If necessary

> ctv::install.views(‘TeachingStatistics’’)

Table 2: CRAN task views.

Agriculture Bayesian CausalInference
ChemPhys ClinicalTrials Cluster
Databases DifferentialEquations Distributions

Econometrics Environmetrics Epidemiology
ExperimentalDesign ExtremeValue Finance

FunctionalData GraphicalModels HighPerformanceComputing
Hydrology MachineLearning MedicalImaging

MetaAnalysis MissingData MixedModels
ModelDeployment NaturalLanguageProcessing NumericalMathematics
OfficialStatistics Optimization Pharmacokinetics
Phylogenetics Psychometrics ReproducibleResearch

Robust Spatial SpatioTemporal
SportsAnalytics Survival TeachingStatistics

TimeSeries Tracking WebTechnologies

1The folder is $R HOME/src/library/PackageName/R/.



Figure 3: How to obtain the code of the functions sd, and mean, which compute the standard deviation and the mean for
a set of values, respectively, from library base, and examples of use of methods and getAnywhere .



3. Graphical User Interfaces

To make it easier to use, there have been various attempts to create a more graphical interface,
from code editors that interact with R to full GUI’s that present the user menus and dialogs, which
get things done right away. While they sacrifice the full power of R for ease of usage, the gain
in usability may take up for it. The goal of these projects is two fold: encourage non-technical
users to learn and perform analyses without programming getting in their way and increase the
efficiency of expert R users when performing common tasks by replacing hundreds of keystrokes
with a few mouse clicks. Consequently, many data scientists prefer to work in the command line,
but beginners should choose a GUI.

Figure 4: Some R GUIs.

We’ve listed a few GUIs below, with a brief description of each one, so the reader does not
waste time searching them.

BlueSky [6]: free and open sourced fully featured statistics and machine learning application
that incorporates comprehensive Six Sigma and Design of Experiments capabilities for
Windows and Mac, all accessible through an intuitive and easy-to-use application, without
programming required. It shares many of SPSS’ features. When we use BlueSky the R
code is hidden until we click the button “¡/¿”. However, for R coding, it uses tidyverse
style while most of the other GUIs use base R functions. Another problem we have found
when using it is that in the latest version there are two alternatives for some procedures,
whose outputs do not match, at least one of them not being correct.

Deducer [7]: designed to be used with the Java based R console JGR, though it supports other
R environments (e.g. Windows RGUI and RTerm), as a free and easy to use alternative
to proprietary data analysis software such as SPSS, JMP, and Minitab. It has a very nice-
looking interface, with a menu system to do common data manipulation and analysis tasks,
and an excel-like spreadsheet in which to view and edit data frames. Probably, Deducer is
the first R GUI to offer in true APA-style word processing tables, a feature that has been
copied by several other GUIs.

Jamovi [8]: free and open statistical software for the desktop and cloud which bridges the gap
between researcher and statistician. Jamovi has an extremely interactive interface that
shows the result of every selection in each dialog box (as JASP) and saves the setting. We
can see the code used at each step, though it uses its own functions from the jmv package.
Jamovi’s ease of use makes it ideal for introducing people to statistics, and its advanced
features ensure students will be well equipped for the rigours of real research when they
graduate. Currently, based on our experience, it seems to us to be the best GUI choice for
a first course in statistics, and for this reason we will develop it in more detail below.

JASP [9]: intuitive interface which offers standard analysis procedures and more advanced
statistical techniques in both their classical and Bayesian approaches. Facilitating Bayesian



analysis and a Machine Learning module is its differentiating feature from other GUIs.
Unfortunately, JASP does not show the R code below. It is available for Windows, Mac
OS X and Linux and we can also download a pre-installed Windows version that will run
directly from a USB or external hard drive without the need to install it locally or run JASP
in our browser to launch it online via rollApp.

R AnalyticFlow [10]: in addition to intuitive user interface, it also provides advanced features
for R experts. They enable to share the processes of data analysis between users with
differing levels of proficiency. What sets it apart from other GUIs for R is that it uses a
flowchart-like workflow diagram to control analysis instead of just menus. With workflow
tools, we get the benefit of the diagram describing the big picture, while the dialog settings
in each node control what happens at each step.

R Analytic Tool To Learn Easily (Rattle) [11]: collection of utilities functions for the data
scientist, that focuses on beginners looking to point-and-click their way through machine
learning tasks. A Gnome (RGtk2) based graphical interface is included with the aim to
provide a simple and intuitive introduction to R for data science, allowing the user to
quickly load data from a CSV file (or via ODBC), transform and explore the data, build
and evaluate models, and export models as PMML (predictive modeling markup language)
or as scores. A key aspect of the GUI is that all R commands are logged and commented
through the log tab. If the work involves machine learning and/or artificial intelligence
instead of standard statistical methods, Rattle is the most adequate GUI [12].

R Commander (Rcmdr) [13]: a Basic-Statistics GUI, implemented as an R package, Rcmdr.
R Commander allows the users to focus on statistical methods rather than on remembering
and formulating R commands. Moreover, by rendering the generated commands visible
to users, it has the potential for easing the transition to writing R commands, at least for
some interested users. The R code it writes is classic and rarely using the newer tidyverse
functions. For this reason, we think it is a very good option for a first course in statistics,
especially if students will have a second course in the subject. Its principal problem is
that it accesses only a small fraction of the capabilities of R, despite been itself extensible
through plug-in packages, many of which are now available on CRAN.

R-Instant [14]: written in Visual Basic, it is currently available only for Microsoft Windows.
However, a Linux version is under development. R-Instant offers one of the most extensive
collections of data wrangling, graphics, and statistical analysis methods of any R GUI. At
a basic level, its graphics dialogs are easy to use and at advanced level it offers powerful
multi-layer support (as the ggplot2 package). To use its full modeling capabilities, we
need to know exactly which R packages we have to use and how their functions work
(recognizing a package::function combination is much easier than recalling it without
assistance). Therefore, it is not a good choice for beginners.

R KWard [15]: blends a nice point-and-click interface with the IDE most advanced of all the
other GUIs reviewed in this work. It is easy to install and start, and it saves all the dialog
box settings, allowing the user to rerun them. However, that is done step-by-step, not all at
once as Jamovi’s templates allow. The code RKWard creates is classic R, with no tidyverse
at all.



RStudio [5]: most trusted IDE for R and Python, available in open source and commercial
editions, which runs on the desktop (Windows, Mac, and Linux). We will describe it more
deeply in the next section.

Tinn-R [16]: generic ASCII/UNICODE text editor/processor for the Windows operating system,
well integrated into the R, with GUI and IDE features. None of its features make it stand
out from the rest.

Despite R is a statistical computing environment for data analysis widely adopted by research
and industry professionals in STEM, social sciences and humanities and more and more educators
use R to teach data analysis, according to our experience, many barriers remain as:

• The initial difficulty of setting up R may be the first obstacle for novice student.

• As R is syntax-based, it may be hard to learn for some students, especially those who come
in with no prior programming experience.

• Same students “hate programming” and initial feelings of fear toward R might turn them
off statistics.

• For many instructors, just the idea of teaching R may be challenging, particularly when
they themselves may have little or no experience with R

In our opinion, there is no perfect user interface for everyone; each GUI for R has features that
appeal to a different set of people, but clearly a good choice of the GUI can break all these
barriers. Based on our experience, teaching statistics courses and subjects for more than 20 years
to students of different levels and professionals from different areas, we recommend RStudio for
statistical computing and Jamovi and/or R-Commander for teaching and applied statistics.

3.1. Jamovi

Jamovi is an advanced real-time statistical spreadsheet, providing a suite of common statistical
methods such as descriptives, t-test, ANOVAs, linear and logistical regression, proportion tests,
contingency tables and factor analysis. Once installed (it is not necessary to install R previously,
like another GUIs, which avoids the first difficulty we mentioned above), when we start Jamovi
we will face a user interface which looks something like Figure 5. On the left side, there is
the spreadsheet view (with each column representing a variable), and the results of statistical
analysis appear on the right side.



Figure 5: Jamovi GUI, with opened windows from tab menu.

To perform an analysis, we only have to choose the statistical tool from the Analysis menu
and select variables and values that appear in the emerging windows. At the same time, the
results will appear on the right side, and they will be updated immediately as we make changes
in the options.

Another interesting feature is that Jamovi also provides an R Syntax Mode which produces
equivalent R code for each analysis. All the analyses included with Jamovi are available from
within R using the package jmv.

3.2. R-Commander

R Commander [13] provides a GUI for R, based on the tcltk package. Another point-
and-click interface loads data and calls R functions to perform the usual analyses involved in
introductory Statistics courses. When we start R Commander, the window shown in Figure 6
will be opened:



Figure 6: Default layout Rcmdr, which is divided into two panes: the source for scripts and Markdown documents (top)
and the R Console (bottom)

Like Jamovi, it has drop down menus that can drive the statistical analysis of data (Figure
6), making it especially useful to R novices. However, R Commander displays the underlying
R code for each analysis the user runs, attached to results in the console. Even more, the code
appears in the upper script, which allows us to reproduce the analysis, get used to the code of
R and start out in programming: which is a feature Jamovi did not facilitate. But, in this case,
the changes we make on data or analysis do not update automatically the results, and we have
to execute again the corresponding instructions (through menus or compiling script instructions
after being modified). R Commander does not generate a report, but a sequence of R code and
the outputs.

Most of usual statistical analysis can be made, although more advanced and specialized tools
are also available, some of them via plugins, which extend the range of application. We can see
their names with:
all.package.names <- rownames(available.packages())

all.package.names[grep("RcmdrPlugin", all.package.names)]

For more information on the R Commander GUI, see the introductory manual distributed
with the package (accessible via the menu: Help → Introduction to the R Commander) or the
Reference [17].



3.3. RStudio

RStudio [5] is our favorite example of a code editor that interfaces with R, because it’s way
ahead of its fellow competitors. The free GUI supports two formats: desktop application, which
is the most used one, and server, which runs on a distant server and we can access it with our
browser.

Figure 7: Default layout RStudio. It is divided into four panes: the Source for scripts and documents
(top-left) that supports direct code execution, the R Console (bottom-left), Environment/History (top-right), and
Files/Plots/Packages/Help/Viewer (bottom-right).

With RStudio all the information we need is available in a single window (Figure 7) to write
code, navigate the files on our computer, inspect the objets we are created, visualize the generated
plots, develop packages, write Shiny apps, ... The placement of these panes and their content can
be customized (see menu, Tools→Global Options→ Pane Layout, Figure 8). Additionally, with
many shortcuts, code completion, smart indentation editor, syntax highlighting for the major file
types you use while developing in R, RStudio will make typing easier and less error-prone.



Figure 8: How to change the default 4-pane layout.

4. Another interesting elements

The easiness for the use of R go further, both for teaching and research. We will point out
and describe briefly some of them:

4.1. Shiny
It’s an R package that easily enables building interactive web applications that can execute R

code on the backend. With shiny, we can host standalone powerful interactive applications on a
webpage, embed interactive charts in R Markdown documents, or build dashboards, entirely in
R. It can perform any R calculation we can run on our desktop.

Shiny combines the computational power of R with the interactivity of the modern web.

4.2. RPubs
RStudio allows us to harness the power of R Markdown to create documents that weave

together our writing and the output of R.If we open an account2 on RPubs [18], we can publish
those documents on the web with only three steps:

1. Create a new R Markdown document in RStudio: File→New→R Markdown.
2. Click the Knit HTML button in the doc toolbar, to preview your document.

3. In RStudio, click the Publish button, in the preview window.

These steps are very intuitive and easy to follow, so it might be the fastest and most comfortable
way to write practices and exercises for R . The success of RPubs has been quite great and it
is already possible to find hundreds of interesting practices, worksheets and examples in all the
languages (Figure 9).

2Completing Register



Figure 9: Example of profile in RPubs [19].

4.3. exams

The package exams provides a one for-all approach to help us to automatically generate, scan
and assess the exams, online text and live voting, which are based on exercises (each one is
written in a file, either .Rmd or .Rnw) in Markdown or LATEXformat, possibly including R code,
for dynamic generation of exercise elements. These exercises can be of different types: single
and multiple choice questions, arithmetic problems, string questions and cloze (combinations
thereof). Output formats include standalone files (Docx, HTML, ODT, PDF3, ...), Moodle XML,
QTI, Blackboard, Canvas, OpenOlat, ILIAS, TestVision, Particify, ARSnova, Kahoot!, Grasple
y TCExam.

The site R/exams contains different question templates with illustrative examples which are
available in different formats of files like markdown, tex or sweave. Exercise templates along
with their output and code can be downloaded and inspected as inspiration for new exercises.
Each question includes:

1. Data generating process in R: Programming a good-data-generating process is often the
hardest part of authoring a new dynamic exercise, but it is crucial for drawing a large
number of random variations

2. Question text

3In addition to fully customizable PDF exams, a standardized PDF format (NOPS) is provided that can be printed,
scanned, and automatically evaluated.

https:/www.r-exams.org/


3. Solution text
4. Meta-information: type of question, correct solution, name/label, etc.

The idea is to build a pool of dynamic exercises. The same exercise can be rendered easily into
varied output formats. The possible questions type are:

schoice (single choice): select the only correct item out of a list of alternatives, with arbitrary
number of shuffled distractors, which can be random numbers and/or typical mistakes.

mchoice (multiple choice): select all correct items out of a list of alternatives, with arbitrary
number of shuffled true or false statements.

num (numeric): compute a single numeric value, within a tolerance interval solving a problems
which can be based on some random numbers.

string (character string): enter the exactly answer as a character string.

cloze (combinations of the above): solve a set of questions combining any of the above types.

R/exams offers different mechanisms for drawing random variations of exams:

• Random selection of exercises for each student.

• Random shuffling alternative answers in single and multiple choice questions.

• Random selection of numbers, text, blocks, graphics, ... using the R programming language,
for a range of question formats.

4.4. tidyverse

Data science is an exciting discipline that allows us to torn raw data into understanding,
insight and knowledge. The tidyverse [20] is an opinionated collection of R packages designed
specifically for data science. They share an underlying design, philosophy, grammar, and data
structures. We can install the complete tidyverse with a simple command
> install.packages(‘‘tidyverse’’)

and run
> library(‘‘tidyverse’’)

to load the following tidyverse packages, and make them available in our R session. These
packages are called the core, because they are used in almost every analysis:

ggplot2 is a system for declaratively creating graphics, which are based on The Grammar of
Graphics.

dplyr provides a grammar of data manipulation, solving the most common data manipulation
challenges.

tidyr includes a set of functions to help us to get tidy data; this is, data with a consistent form
(each variable goes in a column, and each column is a variable).

readr provides a friendly and fast way to read rectangular data (csv, fwf and tsv).



purrr enhances R’s functional programming toolkit by providing a consistent and complete
set of tools for applying functions to element(s) from vector(s) and/or list.

tibble is a modern reimagining of the data.frame. Tibbles are lazy and surly; they do less
and complain more, forcing to confront problems easier.

stringr facilitates the work with strings.

forcats provides a set of useful tools that solve common problems with categorical variables
or factors.

4.5. learnr
This package allows to turn any Markdown document into an interactive tutorial. These

tutorials consist of content along with interactive components (narrative, figures, equations, quiz
questions, videos and interactive Shiny components) for checking and reinforcing understanding,
and automatically preserve work done within them. If a user works on a few exercises or
questions and returns to the tutorial later, he can pick up right where he left off.

Once the package learnr is installed, we can enable the fold Tutorial in any of the right
windows on RStudio, and when we click on it we can access the tutorials from learnr (Figure
10).

5. Discussion

As we mentioned in the Introduction, the employment of Statistics as a tool to analyze
data from research has become essential, especially in the last years. For most scientific or
technological disciplines, even in many social and humanistic fields, there exists the need of
handling basic statistical concepts, in order to be capable of extracting conclusions from the
researchers’ own data or to understand published research. That is the reason why subjects of
Statistics, at different levels, are included in very different academic curriculum, with students
owning previous knowledges and capacities in a very diverse range. Besides, it is obvious that
each statistical technique requires adequate software to perform calculations and create appealing
graph reports.

For all these reasons, there is a growing need for a statistical software as simple and versatile
as possible. After more than 20 years of experience as students, teachers and researchers, our
choice is R, without any doubts. The more we use it, the bigger advantages we find. We highlight
the most important ones:

• It is available for all the operating systems (Windows, Macintosh and Unix systems).

• It can interact with another programming languages.

• It is resource-friendly (it consumes very few system resources).

• It allows to read data from other softwares such as SPSS, SAS, Excel, etc.

• It is a very powerful tool for any kind of processing and manipulation of data.

• It provides great quality charts, exportable to different formats (bmp, eps, jpeg, pdf, pictex,
png, ps, svg, tiff).



Figure 10: RStudio Tutorials powered by the learnr package.



• It includes some advanced and robust techniques that can only be performed with this
software.

• It is regularly updated, and its development has no limits.

• It provides much information about its functions and packages, which are open-coded.

• It is very easy to find free resources to learn and use it.

• It allows to create interactive web applications (apps) with the tool Shiny.

• It enables to make a work flow to write dynamic and reproducible reports, in several
formats (pdf, docx, html).

However, the use of a command console instead of a GUI is a big handicap for a beginner.
Due to this, the attempts to introduce the use of R in a first course of Statistics, or in Applied
Statistics, can lead to bad results, especially for students with no previous programming experience.
As an example, we show the learning rates for the students in the course Use of the package
exams of R to generate exams or quizzes in Moodle, framed into the Training Plan for teachers
and researchers in the University of Extremadura 2022 (see Table 3).

Table 3: Learning rates of the course Use of the package exams of R to generate exams or quizzes in Moodle.

Field Failed Passed Passed (%)

Arts & Humanities 2 0 0%
Science 1 4 80%
Health Sciences 2 3 60%
Social and Legal Sciences 3 5 62.5%
Enginnering and Architecture 0 0 -

Table 4: Learning rates of the course Data visualization and animation with R.

Field Failed Passed Passed (%)

Arts & Humanities 0 1 100%
Science 2 9 82%
Health Sciences 2 2 50%
Social and Legal Sciences 0 9 100%
Enginnering and Architecture 1 2 67%

As we can see in the Table 3, the results were not good, especially for teachers not belonging
to Science field.

In contrast, the results obtained for another course of the same Training Plan entitled Data
visualization and animation with R, where we employed RStudio, were better (see Table 4).
When we use a GUI, even if it involves some programming, like RStudio, the process of learning
can be much more fruitful.

Therefore, the use of GUIs is ideal for people who only analyze data occasionally, freeing
them from the work of writing codes, because they only require to know which statistical tool



they need to use, and locate it in menus and dialogue boxes. In this work, we have described
the most employed GUIs, showing that one important flaw of most of them (like R-Commander,
Deducer, Rattle or Bluesky) is the lack of a key element: reproducibility. Jamovi does not have
this problem, and it was designed to look familiar for SPSS users.

A recent experience of the use of Jamovi in a course took place in November 2022, entitled
The code of Science: keys to make research in Health Sciences, with 16 students. The process of
teaching was far more grateful, and the students rated the methodology employed in the course
with a mean mark of 4.53 (out of 5), even though they were not familiar with Statistics or Jamovi.

6. Conclusions

• Despite of having been designed for data analysis, R belongs to the top ranks of most
employed programming languages, even for general purposes.

• R provides all the usual statistical tools in its base package, but also the most specific and
modern techniques, together with amazing graphical tools, are available in its nearly 20000
packages.

• For users with poor or no programming knowledge, GUIs are very helpful. Many of
them have been developed, with different purposes. We can highlight the easiness and
reproducibility of Jamovi, and the great help R Commander offers to make data analysis
in a very simple way, while the user learns programming.

• RStudio IDE offers a perfect framework to make the most of R for users with programming
skills.

• Some R packages have become tools of great utility in education. For example, exams
allows to create exams and lists of personalized exercises in a very simple way, interacting
with Moodle and another educational platforms.
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